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INTRODUCTION

This handbook gives an orientation to GeoGebra and its use in 

classroom. Here is a set of instructions and activities to introduce 

Geogebra and its tools. If you are familiar with the GeoGebra tools, then

you might go to the activities in a sequence. The description of the tools 

given before each of the activities would help in doing the activities. If 

you are new to GeoGebra, then go through the instructions before 

passing on to the activities. This handbook is prepared through  a series 

of workshop conducted at RIE Mysore to give training for mathematics 

teachers for using GeoGebra. It includes introduction to GeoGebra and 

some illustrations on using GeoGebra  in class room. Along with this 

usage of eXe is also introduced.

TARGET GROUP:

1. TEACHERS WHO ARE FAMILIAR WITH COMPUTERS 

BUT MIGHT NOT HAVE USED GEOGEBRA

2. 40 TEACHERS



OBJECTIVES:

AT THE END OF THE WORKSHOP THE TEACHERS WOULD 

BE 

1. FAMILIAR WITH GEOGEBRA INSTALLATION

2. FAMILIAR WITH BASIC GEOGEBRA INTERFACES

3. FAMILIAR WITH BASIC TOOLS OF GEOGEBRA

4. ABLE  TO USE OF GEOGEBRA TOOLS TO ILLUSTRATE

VARIOUS SECONDARY MATHEMATICS CONCEPTS 

     5. FAMILIAR WITH eXe 

    

 

MATERIAL REQUIRED:

1. A COMPUTER FOR EVERY PAIR OF TEACHERS

2. GEOGEBRA SOFTWARE FOR WINDOWS AND UBUNTU

(TO BE PROVIDED IN A CD)

3. WORKSHOP HANDBOOK 



CONTENT:

The handbook broadly covers the following content area:

1. INTRODUCTION TO GEOGEBRA

2. INSTALLATION IN UBUNTU/WINDOWS COMPUTERS 

AND TECHNICAL REQUIREMENT FOR INSTALLATION

3. BASIC USER INTERFACES 

(ALGEBRA/SPREADSHEET/GRAPHICS/3D 

GRAPHICS/CAS)

4. BASIC TOOLS

5. INPUT COMMANDS

6. RIGHT CLICK FUNCTIONS

7. 3D INTERFACE

 

 



1. INTRODUCTION TO GEOGEBRA

Introduction 

Challenges of teaching mathematics are many. Especially when it comes

to teaching secondary mathematics, as teachers and learners we deal 

with a lot of abstract concepts. We would be required to do complex 

imaginations. Many times it would be necessary to imagine multiple 

things at a time and also attend to more than one geometrical objects. 

Traditional teaching using chalk and board has always been a challenge 

whenever such complex imaginations are involved. A teachers we were 

always in search of tools which would help us in facilitating student 

learning.

Let us take an example :



Consider the line segment AB of length

6 units. 

Suppose that a point C moves in the

plane in such a way that it is equidistant

from the points A and B (i.e. AC = BC )

, what would be the path of C ?

It is easy to see that the path would be a straight line – the perpendicular 

bisector of AB. 

Now consider the same question with a slight change

If the point C moves in the plane in such a way that its distance from A 

is twice the distance from B ( i.e. AC : BC  = 2 : 1) , what would be its 

path ?

Without any visual tool it is difficult to imagine the path of the point. 

 

 



It is worth noticing that the visualization has not only brought out loci of

the points but also makes it easy to see certain class of curves. From here

on a great deal of discussions on which specific point has given a special

type of curve and explorations of reasons behind it could be taken up. 

This is only one illustration of dynamic nature of an open source 

software that we explore in this workshop "GeoGebra"

GeoGebra is a Dynamic Mathematics Software (DMS) for teaching and 

learning mathematics. It is as easy to use as Dynamic Geometry 

Software (DGS) Using GeoGebra teacher can  to bridge the gaps 

between geometry, algebra and calculus. GeoGebra is open source 

software under the GNU General Public License and freely available at 

www.geogebra.org. There, you can either download installers for 

multiple platforms or launch the software directly from the Internet 

using GeoGebra Web Start.

GeoGebra was created by Markus Hohenwarter in 2001/2002 as part of 

his master's thesis in mathematics education and computer science at the 

University of Salzburg in Austria. Since 2006 GeoGebra is supported by 

the Austrian Ministry of Education to maintain the free availability of 

the software for mathematics education at schools and universities. In 

July 2006, GeoGebra found its way to the US, where its development 

continues at Florida Atlantic University in the NSF project Standard 

Mapped Graduate Education and Mentoring.

http://www.geogebra.org/webstart/
http://www.geogebra.org/
http://www.gnu.org/copyleft/gpl.html


GeoGebra was created to help students gain a better understanding 

of mathematics. You can use it for active and problem-oriented teaching,

it fosters mathematical experiments and discoveries both in classroom 

and at home.As per the paper published by Markus Hohenwarter and 

Zsolt Lavicza on GeoGebra, its community and future GeoGebra is 

rapidly gaining popularity among teaching community.

(Reference : http://www.maa.org/external_archive/joma/Volume7/Hohenwarter/)

http://www.maa.org/external_archive/joma/Volume7/Hohenwarter/
http://www.unsam.edu.ar/escuelas/humanidades/centros/c_didacticas/Hohenwarter-Lavicza-GeoGebra-ATCM-Final.pdf


2. INSTALLATION:

A.THE SOFTWARE CAN BE DOWNLOADED FROM THE 

FOLLOWING LINK:

https://www.geogebra.org/

 

B. THE DOWNLOADS OPTION WOULD TAKE YOU THE 

FOLLOWING OPTIONS:

https://www.geogebra.org/


 

C. GEOGEBRA FOR THE DESKTOP WOULD NEED TO BE 

SELECTED IN ORDER TO INSTALL THE SOFTWARE IN

YOUR COMPUTERS. YOU HAVE TO CHOOSE THE 

OPERATING SYSTEM YOU ARE WORKING ON 

(WINDOWS/MAC/LINUX)

 

D.SAVE THE SOFTWARE IN A DRIVE:



 

E. INSTALL THE SOFTWARE BY RIGHT CLICKING AND 

SELECTING OPEN OPTION:

 

 

F. DOUBLE CLICK ON THE GEOGEBRA ICON TO OPEN 

THE SOFTWARE:

THE SCREEN WOULD LIKE THIS:



 

3. BASIC USER INTERFACES

GeoGebra has three basic interfaces (Algebra 

View/Spreadsheet/Graphics View) and two advanced interfaces (3D 

Graphics and CAS).  By default two interfaces are shown. We can 

change the number of interfaces that we would like to see from the View

menu.

 Let us explore the basic features of the GeoGebra window.

Look for Menu bar, Tool Bar, Algebra View, Graphics View and Input 

Bar. 



 

 ACTIVITY 1:

Explore the functions available under each of the pull down menu 

options.

Many of them are self-explanatory.  We would explore some of these 

functions in due course.

For example, follow the below given sequence:

View>Spreadsheet

What have you noticed?



 

A new spreadsheet interface has appeared in the right side of the screen. 

This spreadsheet is one of the basic interfaces.

 Similarly, we can add two more interfaces from the same "View" menu.

View>CAS

View>3D Graphics

 



The CAS interface is useful in doing mathematical problem solving. For 

example, the roots of an equation, x2-5x+6=0 is to be found out, we enter

the equation in the input, and select x= option to get the solution of the 

equation. You may try other such functions.

 

The 3D Graphics interface is useful for generating 3D objects and 

working on it.

 



We can present two graphic interfaces simultaneously by the following 

sequence:

View>Graphics2

The input bar is used for entering algebraic expressions in GeoGebra. 

Details of the input commands are discussed in the next section.

4. BASIC TOOLS:

In GeoGebra construction tools are arranged in 12 sets. All the tools in 

each set is obtained by clicking on the small arrow at the bottom right 

corner of each icon. Keeping the cursor on the tool, a brief description of

the function of the tool is displayed.



 

Let us have a close look on some important tools from each set:

SET 1: MOVEMENT TOOLS:

This tool is used for moving Points, Geometrical figures, Graphs etc. in 

the Graphics view.



For example for moving triangle ABC select the move tool (by clicking 

on the icon), click and drag the triangle.

By clicking and dragging on any vertex of the triangle we can move the 

vertex and the corresponding sides from it. For moving a point or a 

graph (say graph of x2) we can also use the arrow keys on the key board 

along with the move tool. Using move tool click on a point or a graph, 

press and hold any of the arrow keys.

 ACTIVITY 2:

Create a triangle (Using Polygon tool, fifth in the tools section) and then 

move it from its original position keepings its dimensions intact.

Now, move one of the vertex. Notice the difference in the location of the

pointer in the two cases.



DYNAMIC FUNCTIONS: TRACING THE MOVEMENTS:

Now we repeat the above activity with an additional effect. Right click 

on the vertex and select "Trace On" option. Redo the above exercise. 

What do you notice?

 

SET 2: POINT TOOLS:

A. POINT: 

A click on the Graphics view, with the Point tool, gives a new point. If 

we click on a line, circle or a graph using the tool we get a point on it. It 

is possible to move the point only along the object using the move tool. 

You would have noticed that normally cursor will be + on the Graphics 

view. But if we bring it on any object it shows following indication.

B. POINT ON OBJECT:



With the "Point on object" function active, if we click inside any 

geometric object, then the point can be moved inside the object (as well 

as on the object). Similarly, if we click on any geometric object, then the

point can be moved on the object (but not inside the object). 

For example, if we click on any side of a triangle with the tool, we get a 

point which is movable only along the sides of the triangle. But if we 

click inside the triangle, the point obtained is movable inside the triangle

as well as along the sides.

 

 ACTIVITY 3:

Create a circle (using Circle with Center and Radius giving radius as 4). 

Take a point on the circle and create another circle of radius 3. Right 

click on the center of the second circle and choose "Animation on" 

option. Notice that a Play/Pause button appears on the left bottom of the 

Graphics view. This could be used for playing or pausing the animation.

Repeat the exercise with tracing the smaller circle motion.

 

C. ATTACH/DETACH A POINT:



We can attach a point to an object by clicking on the point and the 

object. To detach a point from an object, click on the point with the tool.

 

D. INTERSECT TWO OBJECTS:

This tool is used to mark the point of intersection of curves or 

Geometrical figures. Using the tool, click on the curves one by one and 

select the "intersect Tw objects" tool to get a point of intersection or 

directly identify the point of intersection by clicking on it.

 

E. MIDPOINT OR CENTER:

This tool helps in locating midpoint of a line segment or any two points. 

Click on a line segment/two points to get its midpoint or a circle/ellipse 

to get its center. 

SET 3: LINE TOOLS



A.LINE THROUGH TWO POINTS

Two clicks on the Graphics view with "Line through Two Points" tool 

active results in a line through the points.

B. SEGMENT BETWEEN TWO POINTS

Two clicks on the Graphics view with "Segment between Two Points" 

tool active results in a line through the points.

C. SEGMENT WITH GIVEN LENGTH FROM POINT

A click on the Graphics view with "Segment with Given Length from 

Point" results in following pop-up.



Entering the desired number results in a line segment of mentioned 

length.

 

D.RAY:

Two clicks on the Graphics view with "Ray" tool active results in a ray. 

The first click would be a fixed point and second click would represent 

the direction of the ray.

 

E. POLYLINE:

Click on multiple points, the last point being on the initial point results 

in a figure called polyline.

 

F. VECTOR:

First click on the Graphics view with "Vector" tool active, would be a 

starting point of a vector. Second click would be the end point of the 

vector. The algebra view would display the dimensions of the vector.



 

G.VECTOR FROM POINT

Create a vector and a point first. Now click on the point and vector 

in the sequence creates another vector having same magnitude and 

direction as the earlier vector through the point initially constructed.

 

 ACTIVITY 4:

Draw a circle (using "Circle with Center through Point" tool). Draw a 

line on the circle. Identify the points of intersection. Locate a midpoint 

between these two intersecting points using "Midpoint or center" tool. 

Now move the center of the circle. Notice the location of the midpoint 

drawn.

 

SET 4: SPECIAL LINE TOOLS:

A. PERPENDICULAR LINE:



This tools allows us to draw a line perpendicular to a given line and 

passing through a given point. Draw a line. On activating "Perpendicular

Line" tool, click on the graphic view to get a point and then select the 

line. The desired perpendicular line is drawn.

 

B. PARALLEL LINE:

Parallel line to a given line through a point is drawn identical to drawing

a perpendicular line. One need to activate "Parallel line" tool.

 

C. PERPENDICULAR BISECTOR:

Draw a line segment. Activate "Perpendicular Bisector" tool by selecting

it. Click on the line segment results in a perpendicular segment to the 

given line.

 

D.ANGLE BISECTOR:



Create an angle using "Line Segment" tool. After activating "Angle 

Bisector" tool, select the three vertices such that the vertex where angle 

is formed is in the middle. An angle bisector will be drawn.

 

E. TANGENTS:

Tangents to a graph (for example a circle) of a function can be drawn in 

several ways

• Selecting a point A and a circle gives all tangents through A to the 

circle.

 

 ACTIVITY 5:

Draw a triangle (either draw three line segments or use "Polygon" tool)

Draw a circumcircle to this circle. 

 

 ACTIVITY 6:

Draw a triangle and its in-circle.

 



 ACTIVITY 7:

Draw a circle of radius 3 units. Draw a tangent from a point at a distance

of 4 units. (Find the points through which the tangent passes)

 

 ACTIVITY 8:

 Draw a triangle (using Polygon tool). Draw a line parallel to one of the 

sides through the other vertex. Do this for two more vertices. Compare 

the area of the original triangle with the large triangle. (Would 

congruency of tringles be of any use?)

 

SET 5: POLYGON TOOLS

A.POLYGON

Successive clicks when the "Polygon" tool is active results in a polygon. 

The last click should be on the first point to close the polygon.

 



Note: Algebra view displays the area of the polygon. The polygon 

formed is flexible. The vertices can be moved around.

 

B. REGULAR POLYGON

The first two clicks would decide the length of the side of a regular 

polygon. A pop-up window appears. Number of sides in the desired 

regular polygon need to be entered.

 

C. RIGID POLYGON:

Identical to the "Polygon" tool except that the polygon formed is rigid.

 

F. VECTOR POLYGON:

This tool generates a polygon with sliders for positioning the vertices.



While we draw triangle ABC with the Vector Polygon tool, GeoGebra 

will create four sliders a, b, c and d. (By default the sliders will be 

hidden from the Graphics view. We can show them by clicking on the 

corresponding bullets in the algebra window). Using the slider “a” we 

can move the vertex B horizontally and b helps us to move it vertically. 

Similarly with the help of c and d we can move C.

 

 ACTIVITY 9:

Construct a regular pentagon with sides 4 units. Construct another 

polygon with the area same as the regular polygon.

 

SET 6: CIRCLE AND ARC TOOLS

A.CIRCLE WITH CENTER THROUGH POINT:



First click on the Graphics view with "Circle with Center through Point"

tool active would be a center of the circle. Second click would be a point

on the circle.

B. CIRCLE WITH CENTER AND RADIUS:

Identical to the first one except that the radius need to be entered 

numerically in a pop-up window.

 

C. COMPASS:

This tool is useful in duplicating a circle. After activating "Compass" 

tool, select the circle to be duplicated. Click a point where the center of 

the duplicate circle is expected to be located.

 

D.CIRCLE THROUGH 3 POINTS:



Three clicks on the Graphics view when the "Circle through Three 

Points" active would result in a circle through the points identified 

through the clicks.

 

E. SEMICIRCLE THROUGH 2 POINTS:

Two clicks on the Graphics view when the "Semicircle through 2 Points"

active would result in a semicircle.

 

F. CIRCULAR ARC:

When "Circular Arc" tool is active, three click on the Graphics view 

results in a circular arc. First click defines the center of the arc, second 

an end point, and third the length of the arc.



G.CIRCUMCIRCULAR ARC:

Three clicks define a circumcircular arc with all the three points on the 

arc.

 

H.CIRCULAR SECTOR:

When "Circular Sector" tool is active, three click on the Graphics view 

results in a circular sector. First click defines the center of the sector, 

second an end point, and third the length of the sector.

 

I. CIRCUMCIRCULAR SECTOR:

Three clicks define a circumcircular sector with all the three points on 

the sector.

 ACTIVITY 10:

Construct a tringle with the sides measuring 9 units, 8 units and 7 units.

 



 ACTIVITY 11:

Draw a circle with radius 1 unit. Activate trace of a circle ("Trace on" on

the right click). Select the center using Move tool. Use Arrow keys to 

move the circle. Notice the pattern obtained.

 

 ACTIVITY 12:

Draw a circle with center at “A” passing through “B”. Activate trace of a

circle. Using the Move Tool and Arrow keys, move the center of the 

circle to create following pattern.

 

SET 7: MEASUREMENT TOOLS



A.ANGLE

This tool helps in measuring the angles. Following are the list of angles 

measurement situations using Angle Tool:

 Three sequential clicks on the end points of the intersecting line 

segments with the second click being the vertex where angle is 

formed.
 Click on two segments to measure the angle between them.
 Click on two lines to measure the angle between them.
 Click on two vectors to measure the angle between them.
 Click on a polygon to measure all angles of the polygon.

 

 ACTIVITY 14:

Create an angle, measure the angle by taking the vertices in different 

orders. Notice the difference. Create polygons by proceeding in 

clockwise and counter clockwise directions and use the Angle Tool. 

Notice the difference in the angle measured.

 

B. ANGLE WITH GIVEN SIZE



This tool is useful in creating an angle of desired size. 

For example, in order to create angle ABC with B = 400, first draw line 

segment AB, then using Angle with given Size tool, click on A and B 

successively and enter 400 in the appearing dialogue box. Then we get a 

new point A'. Using Segment between Two Points tool join BA'. A' is 

obtained below the line AB because the angle is created in the counter 

clockwise orientation. If we want A' above AB, after entering 400 in the 

dialogue box click clock wise.

NOTE: WE MAY RENAME THE POINT A' BY USING 

"RENAME" OPTION AVAILABLE ON THE RIGHT CLICK.

 

 ACTIVITY 15:

Construct a triangle ABC with AB=6 units, with angle A=30Angle 

B=75

C. DISTANCE OR LENGTH

This tool gives the distance between two points, distance of a point from

a line, length of a line segment, perimeter of polygon, circumference of a

circle/ellipse.



 Activate "Distance or Length" tool after doing each of the following to 

find the distance/length:

Select two points to measure the distance between them.

 Click a point and a line to measure the distance of the point from 

the line.
 Click on the line segment.
 Click inside the polygon.
 Click on the circle/ellipse.

 ACTIVITY 16:

Measure the length of the other sides of the triangle ABC that you have 

constructed earlier.

Measure the distance of vertex C from side AB.

 

D.AREA

This tool gives the area of a polygon (constructed using "Polygon" tool) 

or a circle/ellipse. 

Click on the polygon/circle/ellipse when the "Area" tool activated would

result in area display.

 



 ACTIVITY 17:

Construct a regular hexagon and find its area.

 

E. SLOPE

Click on a line/line segment results in display of the slope when "Slope" 

tool is active.

 

 ACTIVITY 18:

Find the slope of the sides of the hexagon you have constructed (by 

clicking on the vertex). What pattern do you observe?

 

SET 8: TRANSFORMATIONAL TOOLS:

 

A.REFLECT ABOUT LINE



This tool gives a reflection of an object about a line. Activate "Reflect 

about Line" then click on the object to be reflected and the line about 

which the object to be reflected.

 

  

Note : Reflections are not available in the graph of the function

In the figure given above, if the line is created by giving 'x' in the input 

box GeoGebra treats it as a function such as f(x) = x , so reflection is not

available on it. Instead create it with the input 'y = x ' or using line tools. 

Reflection is not available on the axes also. Use ' x = 0 ' or ' y = 0 ' in the

input box.

 



B. REFLECT ABOUT POINT:

This tool is useful to get the reflection of an object about a point. Click 

on the object and the point results in the reflection.

 

C. REFLECT ABOUT CIRCLE:

This tool gives the reflection of an object about a circle - click on the 

object and the circle.

D.ROTATE OBJECT AROUND POINT:

This tool helps in rotating an object around a point at a desired angle of 

rotation. Select the object. Click on a point to specify the center of 

rotation and then enter the rotation angle into the text field of the 

appearing dialogue window.

E. TRANSLATE BY VECTOR:



Select the object that we want to translate. Then click on a vector or two 

points. The object will be translated by the magnitude of the vector in its

direction. This may be used to create congruent figures.

With the help of move tool make terminal point of the vector

u coincide with the initial point. Observe what happens to 

the congruent figures.

F. DILATE FROM POINT:

This tool allows us to enlarge/reduce an object by a given factor. Select 

the object to be dilated. Then, click on a point to specify the dilation 

center and enter a number (dilation factor) into the text field of the 

appearing dialogue window. If the number is greater than 1, object will 



be enlarged. If the number is less than 1 the object will be reduced. (For 

example: if the number is 2, the object will be doubled, if it is 0.5 it will 

be reduced to half its size.) In the figure, triangle A'B'C' is obtained by 

dilating triangle ABC from the point F with dilation factor 2. We can use

this tool to create similar figures.

 

 ACTIVITY 19:

Draw a line passing through the points (1, 0) and (2, 3). Plot the point (4,

3). Find the reflection of the line about the point.

 

 ACTIVITY 20:

Construct a triangle and a vector joining two points. Translate the 

triangle along the vector. Reduce the magnitude of the vector using 



Move tool. What happens to the translated triangle when the terminal 

point coincides with the initial point?

 

 ACTIVITY 21:

Construct a triangle ABC and a point outside the triangle. Scale down 

the triangle about the point by scale factor 0.5. Move the point D to any 

of the vertices of the original triangle. What do you notice?

 

SET 9: SPECIAL OBJECT TOOLS

A.TEXT

This tool is useful in creating static and dynamic text in the Graphics 

View.

At first, specify the location of the text in one of the following ways:

 Create a point on the Graphics view.
 Activate the "Text" tool
 Click on a point to create a new text that is attached to this point.
 Type the text in the dialogue box say for example "Coordinates of 

point A are"
 Select A from the Objects drop-down list
 Click OK 



 ACTIVITY 22:

Create a parabola x2 -1. Locate the point of intersections A and B  of the 

parabola with the x axis. In the input command enter a = x (A) and then 

b = x (B). Activate "Text" tool. Enter the text "The roots of the function"

then from the "Objects" pull down menu and select function "f". 

Continue typing in the edit box "= 0 are" then select from the "Objects" 

pull down menu "a" and "b".Using move tool move the parabola and  

see the change in text.

Practice this for other parabola.

B. IMAGE

This tool is used to insert an image. Click in the Graphics View, when 

the "Image" tool is active, to specify the position of the image’s lower 



left corner. Then, a file-open dialogue appears that allows us to select the

image from the files saved in the computer.

 

C. PEN

The Pen Tool allows us to add freehand notes and drawings to the 

Graphics View. This makes the Pen Tool useful when using GeoGebra 

for presentations. To erase a portion of the drawing press and hold the 

right mouse button and move the cursor to the portion of the drawing 

one need to erase.

 

D.FREEHAND SHAPE:

A drawing through "Freehand shape" would be recognized as a function.

Roughly draw an ellipse with "freehand shape" tool active, GeoGebra 

converts into an ellipse.

 

E. RELATION:



The relation function helps us know a general relationship between two 

objects. For example, draw two parallel line segments and use "Relation 

tool. The two relation between them as parallel line segments is 

displayed.

SET 11: ACTION OBJECT TOOLS:

A.SLIDER:

Slider is the most powerful tool of GeoGebra which makes GeoGebra 

dynamic.

Slider, can be considered as a variable, which takes any value between 

two numbers.

To create a slider, select the "Slider" tool and click on the Graphics view.

A window will appear. There are three options with in it – Number, 

Angle, and Integer.



 

Number Slider:

Select Number in the slider window. Give a name for the slider. This 

name is important as we need it in any construction using the slider. Set 

the Minimum value, Maximum value and Increment of the slider. Click 

Apply.

 

Angle Slider:

Select Angle in the slider window. For Min and Max, enter values 

between 00 and 360.

 

Integer Slider:

Select Integer in the slider window.



 

Advanced slider properties:

Create a slider with Min: -3 and Max: 3. Enter x2+a in the input bar. We 

get a function in the Algebra View and its graph in the Graphics View. 

The function and its graph changes as we change the value of the slider 

Note that the slider has a variable "a".As we vary the value of "a", the 

graph varies accordingly displaying a variation in "a".

We can change the value of a slider in one of the following ways:

 Click on the slider and drag
 Click on the slider and press any of the arrow keys
 Right Click on the slider and click Animation On in the appearing 

window. Then a play/pose button appears at the bottom left corner 

of the Graphics View, with which we can start/stop the animation.
 Link the slider with an Input Box. We can change its value by 

typing the required value in the input box.

Slider can be set for an already defined variable.

 ACTIVITY 23:

Construct a regular polygon with a length of side 3 units such that we 

can change the number of sides of the polygon with the help of "Integer 

Slider"



 

 ACTIVITY 24:

Plot points A and B. Create an angle slider (with 'α ' as an angle). Rotate 

point B about A with the help of an angle slider (select   'α ' as an angle 

of rotation in the dialogue box). Draw a circle with the center at the 

moving point passing through B. Trace the rotation of the circle. 

Animate the rotation (slider).

B.  CHECK BOX

Check box is used to hide/view the objects that are constructed. 

Displaying and hiding objects comes to good use when we illustrate 

multistep processes. Click on the Graphics view with "Check Box" tool 

active results in a pop-up window.



A caption for the object need to be given. The dropdown menu lists all 

the constructed objects. Select the one for which check box is added.

 

There is another method to include objects in an existing Check Box. 

Create a Check box. Right click on the object -> Object Properties -> 

Advanced. Give the name of the Check box (not the caption, name is 

given in the algebra view under the heading Boolean. Mere right click 

on the check box also gives the name of the Check box) in box 

"Condition to show object". 

 

 ACTIVITY 25:

Create a circle and insert a Check Box linking it with the circle.

C. INPUT BOX:

Input Box can be used to enter a specific function/value of a variable. 

Click on the Graphics view with the tool and enter a caption in the box 

for it. From the Linked Object drop down menu select an object (which 

is already constructed) to link with the input box and click Apply. We 

can edit the properties of a linker object using the input box.



 

For example, if an input box is created with the caption circle and the 

circle with center A and radius 2 is linked with it we get an input box as 

shown in the figure. Instead of Circle [A, 2] in the input box, if we give 

Circle [B, 3], we get a circle with center B and radius 3.

If we link a slider with an input box, we can change the value of the 

slider by typing in the box.

 

 ACTIVITY 26:

Redo the input box to circle with a radius exercise (given above) by 

including a slider to vary the radius.

 

SET 12: GENERAL TOOLS



A.MOVE GRAPHICS VIEW:

Used to move the Graphics view. Click, hold and drag the drawing pad 

in the Graphics View to change its visible area.

 

B. ZOOM IN

Click on any place on the drawing pad to zoom in.

 

C. ZOOM OUT

Click on any place on the drawing pad to zoom out.

 

D.SHOW/HIDE OBJECTS



If we click on any object with the tool, it will be hidden from the 

Graphics view when we select any other tool. To see the object again, 

select the tool.

 

E. SHOW/HIDE LABEL

Click on an object to show or hide its label.

 

F. COPY VISUAL STYLE:

This tool allows us to copy visual properties (e. g., color, size, line style)

from one object others. To do so, first select the object whose properties 

we want to copy. Then, click on all other objects that should adopt these 

properties.

 

G.DELETE OBJECT



Click on any object that we want to delete. Note: We can use the Undo 

button if we accidentally delete the wrong object.

 

5. INPUT COMMANDS

Most of the constructions can be done by typing commands in the Input 

bar. For giving a command, type it in the Input Bar and press Enter key. 

Output of the command is obtained in the Graphics view and the 

Algebraic view.

A list of all input commands is available by clicking on the button at the 

right side of the input bar. Symbols are also available in the Input bar. 

The arrow key in the right of the input bar gives a list of input 

commands used recently. These commands can be edited and useful for 

a quick use.

 



SOME EXAMPLES ARE GIVEN IN THE FOLLOWING 

TABLE.

Input

Command

Output

 Algebra View Graphics view

(2,3)  A (2,3) Point  A

x^2 Function  f(x) =  x2 Graph of the function f

3x + 2 Function f(x) = 3x+2 Graph of the function

y = 3x+2 Line c : y = 3x+2 line

abs(x) f(x) = lxl Graph of  |x|

Polygon [A,B,C,D]

where A,B,C and 

D are already 

created points

Poly 1 Quadrilateral ABCD

Polygon [(0,0),

(2,3),(2,1)]

Polygon  Triangle 

 If [-2 ≤ x ≤ 2,

x^2]

f(x) = x2  , for  -2 ≤ x ≤

2



Input

Command

Output

 Algebra View Graphics view

Sequence

[ x^2+a , a ,0, 2,

0.5]

Creates a set of 
functions

{x2 , x2  + 0.5 , x2 +1 ,    
x2 + 1.5 , x2  +2 }

Sequence 

[Circle[(i, 0), 

(0, 0)], i, 0, 3,

0.2]

Creates a set of circles 

passing through the 

origin and centered at 

(0.2,0),(0.4,0) etc

 

 ACTIVITY 27:

Practice the input commands given in the table.

 

6. RIGHT CLICK:



We can edit the properties of an object by right clicking on it. For 

example, if we right click on the graph of a function, we get a window as

follows

 

List of Right Click functions is summarized here:

Function f Name of the function is f

Show Object  Hide the graph by clicking on the check box

Show Label Show / hide the name of the function

Trace On Traces the path of a moving object

Copy to input Bar Copies the expression of the function to input bar

Rename Change the name of the object

Delete Deletes the object



 ACTIVITY 28:

Generate an object in the Graphics View and explore the right click 

options.

 

OBJECT PROPERTIES:

The following windows is displayed on selecting Object Properties:

The tabs would allow us to do the following changes:

Basic: Editing the name, definition, Label display.



Color: Editing the color of the object

Style: Editing the Line thickness, line style etc.

Algebra: We can change the style of the algebraic expression.

Advanced: Condition to show object.

 This allows us to control the visibility of the graph. For this either 

enter the name of a Check Box or the name of a slider. 
 E.g.: If 'a' slider and if we give ' a > 1 ' in the Condition to Show 

Object box, the graph will be visible only when the value of ' a ' is 

greater than 1.

 



DYNAMIC COLOURS:

We can change the colour of the graph using sliders.

Construct three sliders with Min: 0 and Max: 1.

Right Click on the object>Object Properties> Advanced

Give the name of one slider each in the boxes Red, Green, and Blue and 

click Close. 

Now the colour of the graph will change according to the value of the 

sliders.

 

7. ADDITIONAL TOOLS FOR 3D GRAPHICS

 

The first five set of tool for 3D graphics are identical to the Graphics 

View. Hence we explore sixth set of tools onwards.

SET 6:

A.CIRCLE WITH AXIS THROUGH POINT



We can construct circles with given axis and passing through a given 

point - with the tool active, select a line and a point.

 

 ACTIVITY 29:

Draw a circle passing through the point (3, 3, 2) and axis passes through 

the points (1, 2, 0) and (3, 1, 1)

 

B. CIRCLE WITH CENTER , RADIUS AND DIRECTION

We can construct circles with given centre, radius and perpendicular to a

given direction with the tool active select the centre and a vector/two 

points

 

 ACTIVITY 30:

Construct a circle centred at the origin and perpendicular to the line 

passing through the points (1, 1, 2) and (3, 2, 1)  

 



SET 7:

 

A.INTERSECT TWO SURFACES

With the tool active, select two objects (for example two spheres) to 

produce the curve of intersection

 

 ACTIVITY 31:

Construct two spheres of radius 3 centred at the points (0, 1, 2) and (1, 2,

1)

 

 SET 8:

 

A.PLANE THROUGH 3 POINTS

With the tool active, select three points to construct the plane passing 

through them.



 

 ACTIVITY 32:

Construct the plane passing through (0,0,0), (1,2,1) and (2,1,3)

 

B. PLANE 

Creates a plane through 3point/through a point and a line / contains two 

intersecting lines / contains a polygon.

 

 ACTIVITY 33:

Draw a line passing through the points (2, 0, 1) and (1, -2, 2). Construct 

the plane that contain above line and the point (2, 3, 1)

 

C. PERPENDICULAR PLANE 

Creates a plane passing through a given point and perpendicular to a 

given line / vector



 

 ACTIVITY 34:

Construct the plane passing through the point (1, 2, 1) and perpendicular

to the x axis.

 

D.PARALLEL PLANE

Creates a plane which is parallel to a given plane and passing through a 

given point.

 

 ACTIVITY 35:

Construct a plane through the points (1,0,1),(2,-1,3) and (3,2,1). 

Construct another plane passing through the point (2, 3, 2) and parallel 

to the first plane.

 

SET 9:

A.PYRAMID



Creates Pyramids with given base and vertex by selecting the base 

polygon and the vertex

 

 ACTIVITY 36:

Make a square pyramid with base length 3 and height 4

 

B. PRISM

Creates prism/parallelepiped with given base and top. To construct a 

prism select a polygon for its bottom and the first point on its top (First 

point is the other end of the edge that joins the vertex at the bottom - 

where we started construction of the base polygon- and the top).

 

 ACTIVITY 37:

Create a parallelepiped with base determined by the parallelogram 

whose vertices are  (0,0,0), (3,0,0) , (4,2,0) , (4,2,0) and first point on the

top is (1,3,1)

 



C. EXTRUDE TO PYRAMID OR CONE

Using this tool we can create pyramid or cone with given base and 

height – for this select the base and enter the height.

 

 ACTIVITY 38:

Construct a cone of base radius 3 and height 4

 

D.EXTRUDE TO PRISM OR CYLINDER

Creates a Prism or Cylinder with given base and height

 

 ACTIVITY 39:

Make a rectangular box of length 4, breadth 3 and height 5

 

E. CONE  



Creates a cone with given vertex and base radius – choose the centre of 

the base then the vertex and enter the base radius

 

F. CYLINDER

Choose the centre of top and bottom circles and enter radius to make a 

cylinder.

 

G. REGULAR TETRAHEDRON 

With the tool active, select two points to create a regular tetrahedron 

with the selected points as two vertices. 

 

H.CUBE

With the tool active, select two points to create a cube with the selected 

points as two end points of an edge.



 

I. NET

With the help of this tool we can create net of polyhedrons (pyramid, 

prism etc.). With the tool active, click on a polyhedron to create its net. 

A slider will appear on the graphics view, with the help of which we can 

open or fold the net

 

 ACTIVITY 40:

a. Make a regular hexagonal pyramid of base length 2 units and 

height 5 units. Make its net
b. Make a square prism of base length 3 and height 4. make its net
c. Make a parallelepiped and its net.

 

SET 10:

 

A.SPHERE WITH CENTRE THROUGH POINT

Creates a sphere with given centre and passing through a given point



 

 ACTIVITY 41:

Construct the sphere with centre at the origin and passing through the 

point (1, 2, 1)

 

B. SPHERE WITH CENTRE AND RADIUS

Creates a sphere with given centre and radius.

 

C. VOLUME 

Shows volume of a solid.

 

SET 11:

A.REFLECT IN PLANE

Creates the reflection of an object on a plane



 

 ACTIVITY 42:

1. Construct the plane perpendicular to the y axis and passing through

the point (0, 3, 0).
2. Construct the sphere with its centre on y axis and radius 2.
3. Construct the reflection of the sphere on the plane.

 

SET 12:

A.ROTATE AROUND LINE

With this tool we can rotate an object about a line by an angle – for this 

click on the object, line and enter angle of rotation. 

 

 ACTIVITY 43:

Create a cone with centre at the origin radius 2 and vertex (3, 0, 0). 

Rotate this cone about the line through (3, 0, 0) and perpendicular to XY

plane

 



SET 14

A.ROTATE 3D GRAPHICS VIEW

Click and drag the 3D graphics view to rotate it

 

B. VIEW IN FRONT OF

To view an object from the desired face  select view in front of tool and 

click on the required face.

 ADDITIONAL ACTIVITIES:

1. Draw a rectangle with adjacent sides measuring 5 and 4 units.
2. Draw rectangles with perimeter 20 and variable sides. Find the 

area of rectangles. When would the area becomes maximum?
3. Draw rectangles with Area 25 and variable sides. Find the 

perimeter of the rectangles. Find the position at which the 

perimeter becomes minimum.
4. Draw isosceles triangles with base 6 units.
5. Draw triangles with base 6 units and area 12 square units.
6. Draw right angled triangles with hypotenuse 5. 



7. Draw triangles with base 5 units and the angle opposite to the base 

measures 600. 

************************



EXE learning Manual

INTRODUCTION TO EXE LEARNING

The e-Learning XHTML editor (eXe) is an authoring environment to assist teachers and academics in
the design, development and publishing of web-based learning and teaching materials. Teachers can develop
content without any programming knowledge in HTML or complicated web-publishing applications. It’s an
easy to  learn,  easy to  use  and easy  to  share  ICT tool.  Teachers  can incorporate  many online or  offline
resources like audio, video, flash, animations, web links, Wikipedia pages and interactive elements into  eXe
which makes lesson intuitive.

ADVANTAGES OF EXE

1. Easy to learn and use.
2. You can easily create professional looking dynamic web based learning material.
3. eXe can also be used as offline authoring tool, so we can share our resources offline without internet.
4. eXe is WYSIWYG (What you see is what you get) which enables you to see how the content will 

look when published online.
5. You can use it without any programming knowledge.
6. eXe is designed for academics. It has many pedagogical tools built in which we can use it in our 

material. 
7. It has many interactive elements for evaluation.
8. It provides many ways to share and export.
9. It provides platform to integrate different types of content available on the internet.
10. The content generated in eXe can be used in any learning management systems.

INSTALLATION

FOR WINDOWS:

1. Go to website http://eXelearning.net/downloads/

It has two versions. Either you can install by downloading install version or else you 
can run the program without installing by downloading version ready to run. 
Download the required files.

2. Let us see, how to install a eXe learning from install version.



1) Save the installer downloaded from the website.

2) Double click on eXe installer to open.
3) It will take you to eXe installer setup wizard.

4) Click on “ I agree “ in license agreement



5) Choose a destination folder.It is better not to change any settings here.



7) Click on finish to complete installation.

8) Launch the application by double clicking eXe icon on desktop or from 
startmenu in windows.

3. Let us see, how to run eXe from ready to run installer.
1) Go to http://eXelearning.net/downloads/

 eXe downloads section, and download the ready to run installer.

2) Save the ready to run installer in your computer.



3) Double click on ready2run eXe installer to launch it.

4) EXe will launch and run in the computer.

FOR LINUX

1. Go to http://eXelearning.net/downloads/  select your linux operating system.

2. If you are an Ubuntu user, you should download the debian package. Click to 
download. Save the file.

http://exelearning.net/downloads/


3. It will start downloading deb package. Double click to open it.

4. It will start installation in Ubuntu software center. You should provide authentication 
password to complete installation. Type your system administrative password here.

5. After installing you can launch application by clicking on applications→ Education → 
eXe.



FROM SOURCE CODE

1)  If you are a geek who want try the source code for eXe learning, visit
http://eXelearning.org/wiki/SourceControl

WORKING WITH EXE

 Authoring Workspace eXe's authoring workspace is made up of two work areas. The left sidebar 
contains the tools that content authors can use to enter and organise content. While the authoring space 
behaves as a drafting board where content authors using the iDevice tools can edit and view content. 
Currently, a properties tab is also accessible in this work space. The properties tab is designed to enable 
content authors to define basic metadata and taxonomy for the project as well as add header graphics and a 
title.

Properties tab

Outline pane

http://exelearning.org/wiki/SourceControl


I-devices pane

Authoring space

Once you open the main window of eXe you can see two parts. On left you can see outline pane and
idevices pane. On right you can see authoring pane. It is important to outline your content according to
hierarchy. You must first arrange your content into preferred hierarchy and taxonomy, e.g. topics-sections-
units, or books - chapters - notes, etc. 

The iDevice (instructional Device) pane is a collection of structural elements that describe learning
content and activities. Examples of these include, objectives, pre-knowledge, case studies, or even free text.
Learning content is created by selecting iDevices from the iDevice menu and entering your learning content.
A learning resource may consist of as few or as many iDevices as needed to deliver the learning content.
Users can include images, math equations, and multi-media (including the majority of current video formats
and mp3) - or attach any other resource - into any iDevice's rich-text fields. If the iDevice you need is not
amongst those generic iDevices listed in the iDevice pane you may be able to create your own new iDevice
using the iDevice Editor. 

EXE MENU OPTIONS 

The Menu contains the following options: File, Tools, Styles, and Help. These are described 
briefly below: 

File 

contains options for Opening previous content you have worked on, Saving content, 
Exporting content as a Web Site or SCORM package, or 

Merging a previously authored package into the package you are currently working on 

Tools 
launch the iDevice editor, or select the language (preferences) that you would like to use eXe
in, or refresh the display (if eXe seems to stop responding) 

Styles select a style for your content 

Help information to report a bug or learn more about eXe 

EXE SIDEBAR  



Located at the far left of the screen is the eXe sidebar
containing the Outline and iDevice panes. 

The basic tree type structure allows users to add content

pages (branches, children or nodes) to the trunk (Home

page). Multiple levels can be added under this structure

however guidelines for good content design suggest a

fairly flat structure to be ideal for most learning content. 

The Outline Pane 

 

The Outline tool set allows you to define the structure
your project will take. This is particularly useful for large
or complex projects that contain many parts or topics.
The Outline pane uses a tree structure to organise related
pages. This first page or node is the Home page. This is
the top level page and will always display as your
project's home page when published. 

Function Description 

Home Page 
The Home page is the first page displayed when the project is exported to the web or
an LMS. This is a parent page and additional child level pages can be added under 
this page. 

Adding pages 
To add additional pages select the parent node by highlighting the parent level and 
click the <Add Page> button. 

Delete pages 
To delete a page, select the page you want to delete and click the delete button. A 
dialogue message displays to check this action. Click OK to continue. 

Renaming pages 
Select the page you want to rename and click the rename button or double click on 
the node. A dialogue message prompts you to enter the new name. Enter the name 
and click OK. 

Extracting & 
Merging pages 

Merging pages allows you to take an elp file and merge the content of that file into 
another elp file, or to take a page from an elp file and extract it to create a new elp. 

To insert a file select the node you wish to insert the content into then select Merge, 
Insert Package from the File menu. Alternately, you can rightclick on a node and 
select Insert Package. The Browser dialogue is displayed. Browse to the elp file you 
want to insert and click Open. The new file content will now appear in your open 
elp file. 

To extract a node, select the node from your open elp file, select File, Merging, 
Extract Package (or right-click). A save dialog is displayed. Enter a file name for the
node you are extracting and click Save. A confirmation message will be displayed. 



Promote/Demote
arrows 

The promote/demote arrows are located beneath the outline pane. Selecting a node 
and clicking on one of the arrows will change the position of that node with the 
outline structure. 

THE IDEVICE PANE



The iDevice (instructional device) pane is a collection of structural
elements that describe learning content. Examples of these include,
objectives, pre-knowledge, case studies, free text. Learning content is
created by selecting iDevices from the iDevice menu and entering your
learning content. 

 

IDEVICE DESCRIPTIONS 

iDevices Description 

Activity 

An activity can be defined as a task or set of tasks a learner must complete. 
Provide a clear statement of the task and consider any conditions that may help or 
hinder the learner in the performance of the task. 



Case Study 

A case study is a story that conveys an educational message. A case study can be
used  to  present  a  realistic  situation  that  enables  learners  to  apply  their  own
knowledge and experience to.  When designing a case study you might  want to
consider the following: 

What educational points are conveyed in the story 

What preparation will the learners need to do prior to working on the case study 

Where the case study fits into the rest of the course 

How the learners will interact with the materials and each other e.g. if run in a
classroom situation can teams be setup to work on different aspects of the case and
if so how are ideas feed back to the class.

Cloze Activity 

Cloze activities prompts learners with a piece of text with significant phrases or 
words missing. Learners demonstrate their knowledge and understanding of the 
concepts presented in the text by filling in the missing phrases or words. A useful 
device for testing reading comprehension and language skills. 

External website 
The external website iDevice allows you to attach an external website url to your 
content. This feature allows learners to browse the external website without the 
need to open a new browser window. 

Free Text Area 
The majority of a learning resource will be establishing context, delivering 
instructions and providing general information. This provides the framework 
within which the learning activities are built and delivered. 

Image Gallery The gallery iDevice allows you to upload and label multiple images. 

Image Magnifier 
The image magnifier allows the learner to view parts of an image in a magnified 
state. 

Java applet This is iDevice that allows users to load simple java applets into the eXe content. 

Multi-choice Question 

Although more often used in formal testing situations MCQ’s can be used as a 
formative testing tool to stimulate thought and discussion on topics students may 
feel a little reticent in responding to. 

Multi-select Question 
This iDevice provides the ability to choose more then one correct response to a 
question. 

Objectives Objectives describe the expected outcomes of the 

learning and should define what the learners will be able to do when they have 
completed the learning tasks. 

Preknowledge Prerequisite knowledge refers to the knowledge learners should already have in 
order to be able to effectively complete the learning. Examples of pre-knowledge 
can be:
 Learners must have level 4 English 



Learners must be able to assemble standard power tools 

RSS 
The RSS iDevice allows users to import a snapshot of RSS content into your 
authoring environment where it can then be edited. This iDevice requires that the 
author be connected to the internet. 

Reading Activity 

Provide learners with structure to their reading activity. This helps put the activity 
in context for the learner. It is also important to correctly reference any reading 
materials you refer to as this models best practice to the learners. Not always 
essential if covered in the course content but providing feedback to the learner on 
some of the main points covered in the reading may also add value to the activity. 

Reflection 
The Reflection iDevice allows you to pose a question for the learner to consider of
set an activity for learners to complete before receiving some guidance by clicking
on the Feedback button. 

SCORM Quiz 
The SCORM Quiz iDevice bundles questions to form a quiz assessment. This 
assessment is then managed by the Learning Management System (LMS) to 
enable scoring. 

True/False Question 
True-false questions present a statement that requires the learner to make a 
determine whether or not the statement is true or not. 

Wiki article 

The wiki article idevice takes a snap shot of an article and embeds it into your eXe
content. This iDevice requires that the author be connected to the internet. 
Changes made to the article will not automatically be updated to Wiki so changes 
made on your local machine to the wiki content in your content should be 
submitted back to the wiki where appropriate. 

ADDING AN IDEVICE 



FORMATTING CONTENT USING RICH TEXT EDITOR 

Using the iDevice rich text editor you enter your content as you would if you were using standard word
processing type applications. Formatting of your content at this stage is relatively simple and the editing
toolbar located above each editable frame provides some basic formatting, searching and linking functionality.

  Clear field content 

 Font styles: bold, italic, and underlined 

 Font size selection menu 

 Font family selection menu 

 Text and text background colors 

 Font styles: subscript and superscript 

 Text alignment: left, center, right, and full 

 Lists: unordered and ordered 

 Text margins: outdent and indent 

 

Anchor: insert an anchor for internal linking (via the chain text-link button); only 
supported in exports of type Web Site .

 Cut and copy to, and paste from, clipboard 

 Paste clipboard as text, and paste from Word (to cleanup Word formatting) 

 Help button for TinyMCE, the rich text editor 

 

Image: insert an image into your content (to link to a URL or to embed a file); or edit 
its properties 

 

Media: insert a media clip into your content (to link to a URL or to embed a file); or 
edit its properties.

 
Math: generate or edit an embedded math image using LaTeX. 



 Insert an advanced horizontal rule 

 Insert a table 

 Table properties: row and cell 

 Table rows: insert row before or after, or delete 

 Table columns: insert column before or after, or delete 

 Table: split and merge 

 

Text Link: insert a link (to an external URL, an internal anchor, or to embed an 
attachment file); or edit its properties; or remove the link (via the broken-chain button) 

 Undo and Redo edits or formatting 

 Insert a custom character symbol 

 HTML raw source editor (advanced users only) 

 Remove formatting from selected text 

IDEVICE CONTROL BUTTONS 

 

Each iDevice comes with a standard set of iDevice control buttons. These controls are described 
below. 

GREEN CHECK MARK 

Each time you enter content into a field you must click on the check mark. This records
the content in the iDevice and switches the view to preview mode. Note This does not save your
work!!! 

BLUE UNDO ARROW 

By clicking on the blue undo arrow, you will undo any changes that might have made to
the  iDevice  since  opening  it  for  edit.  Please  note  that  some  iDevice  editing  functions  (for
example, Add or Remove a Question or Option in any of the quizzing iDevices) do not support

an undo, and will result in the arrow appearing as:  



Red X 

By clicking on the red X you will delete the iDevice and any content entered. 

Up and down arrows 

The up and down arrows allow you to change the order of the iDevices displayed on your screen.

MOVE TO MENU 

You can move I Devices containing content between and within nodes. This is done by opening
the drop down menu and selecting the node you wish to move it to. 

IMPORTING GEOGEBRA FILES INTO EXE. 

There are two ways to import GeoGebra files into eXe.

IMPORTING AS JAVA APPLET INTO EXE.

1) We should create our mathematical lesson in GeoGebra and save it as a .ggb file, which is the

default extension in GeoGebra.

2) To do this, in GeoGebra, select File -> Save, and type the name of the lesson. It's important to

remember which folder the lesson was saved in; we'll  need it later to import the file into 

EXELearning.

3) Once the lesson is saved, open EXELearning and click on the "Java Applet" idevice. This will

put a new IDevice in your content in edit mode.



4) In the "Type" field, choose GeoGebra Applet.

5) Click on add files, locate your ggb files from your computer. Click on open. It may slightly 

differ in Ubuntu.

6) Click on upload



7) If all has gone well, you should be able to click the green "tick" mark near the bottom and 

you should be able to see your GeoGebra applet working perfectly.

NOTE: In some browsers you need to allow java applet to run by changing java security 

settings. You can learn more from below links. 

https://www.java.com/en/download/help/jcp_security.xml and 

https://www.java.com/en/download/help/java_blocked.xml.

IMPORTING AS HTML SOURCE CODE INTO FREETEXT IDEVICE

8)   Open your GeoGebra ggb file in GeoGebra application. Go to File→ Export→ Dynamic 

worksheet as webpage

9)   In the upload windows, Enter title for your file, You can add description about your ggb file 

in other two text fields for above and below construction. Click on upload.

https://www.java.com/en/download/help/java_blocked.xml
https://www.java.com/en/download/help/jcp_security.xml


10) GeoGebra will prepare for uploading ggb file to GeoGebra tube

11) Once uploading is complete, It will land you in GeoGebra tube website.Fill up any necessary 

details. Come down to the bottom of the page. Click on continue.

12) You can do any settings if you want.Drag down to the bottom of the page.Click on save 

button.





15) You may get a new tab with source code, press Ctrl+A to select all the content, press Ctrl+C 

to copy the contents to clip board.

16) Now launch eXe, go to the topic/subtopic where you want to place this ggb file. Select 

FreeText iDevice.



17) Click on HTML button in the freetext idevice pane.

18) Press Ctrl + C to copy the source code from clipboard to html editor window.



19) Click on update button.

20) Click on right mark in freetext iDevice. You will see interactive GeoGebra applet in browser.


